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Thank you for purchasing the Mini Spectrum Analyzer.  This device will let you observe 

radio signals in the 2.4 GHz band.  This band is heavily used throughout the world for 

many types of low power, short distance communications.  Examples of this are WiFi 

(802.11b), Bluetooth, ZigBee, Wireless USB and cordless phones.  In addition, police 

radar and microwave ovens use this frequency band.  Your spectrum analyzer will not 

allow you to “listen in” to any of these communications, but it will let you see the 

transmissions, understand what frequencies they are at, understand how strong the signals 

are and see how those signals relate to other signals.  Although your spectrum analyzer is 

not a calibrated piece of test equipment (such units cost much, much more!), it can be 

extremely useful for many tasks that were previously done with much bigger and more 

expensive equipment. 

The Mini Spectrum Analyzer comes in two parts.  The RF (radio frequency) portion is a 

small circuit board with a special radio communications chip on it.  This board plugs into 

another board, called Arduino.  Arduino has a microprocessor chip that controls the radio.  

It also has a USB port for communicating with a PC running Windows.  If you have not 

already bought an Arduino, one can be purchased from one of the sellers at 

http://www.arduino.cc/en/Main/Buy.  Be sure to get the version called “Arduino 

Diecimila” or “Arduino Duemilanove”. 

 

Installing the Arduino Software 

The Arduino board was designed for electronics hobbyists as an inexpensive platform for 

developing small projects requiring a microprocessor.  To use it, you must download the 

software for running it.  Don’t worry – you won’t need to know anything about 

developing software to use the spectrum analyzer.  The software installation has three 

parts: the Arduino USB driver, the Arduino firmware and the Windows software.   

 

Installing the Arduino USB Drivers 

• To set up your Arduino board, follow the instructions at: 

http://www.arduino.cc/en/Guide/Windows 

Follow steps 1 through 4, including installing the USB driver. 

The Arduino package on that site is rather large, so you may follow the link to get 

just the FDTI driver if you prefer. 

 



Installing the Arduino Firmware and MiniSA Windows Software 

• Download the MiniSA software package from 

http://www.dunehaven.com/minisa_DL.htm 

• Plug the Arduino board into your PC’s USB port.  Windows should recognize the 

board and tell you that your hardware has been installed and is ready for use.  Run 

the “minisa setup.exe” file that you just downloaded.  This will install the MiniSA 

software as well as software to program the Arduino with the spectrum analyzer 

firmware. 

• Run the Arduino Programmer software.  This will be run by default after running 

the setup file or you can run it by selecting “Arduino Programmer” from the 

“Mini Spectrum Analyzer” group added to your Start/Programs menu during 

installation. 

• The Arduino Programmer window will appear.  It looks like this: 

 



 

• Normally, the program automatically locates the com port associated with the 

Arduino.  In rare situations, that does not work and the com port can be selected 

manually.  Leave the “Automatic” com port button selected unless you have 

problems. 

• Before programming the Arduino, you must inform the software what kind of 

AVR part your Arduino has.  For Arduino Diecimila, choose “ATMega168”.  For 

Arduino Duemilanove, look at your Arduino board.  The processor will be labeled 

either ATMega168 or ATMega328. 

• Next, click “Browse…” and choose the MiniSA.hex file located in the installation 

directory.  Click Open. 

 

• Click Program on the Arduino Programmer window.  The software will place the 

spectrum analyzer software into the Arduino’s flash memory.  The programming 

process takes about 10 seconds.  When complete, the window will look as shown 

below. 



 

• The software installation is complete. Close the Arduino Programmer window. 



 

Installing the spectrum analyzer board 

Unplug the Arduino from the USB cable.   

Plug the spectrum analyzer board into the Arduino board by lining up the pins on the 

connectors as shown below and pressing the boards together.  Note that there are more 

pins on one side than the other. 

 

Plug the USB cable back into the Arduino.  Your spectrum analyzer is now ready to use. 



 

Using the MiniSA software 

You start the MiniSA Windows software by selecting “Mini Spectrum Analyzer” under 

the Start/Programs menu. 

When you first run MiniSA, you should see a window like the one below. 

 

What you are seeing is a live image of the 2.4 GHz environment around your spectrum 

analyzer. Along the bottom of the screen are the frequencies (in MHz).  Along the right 

edge are amplitudes in dBm.  The dBm numbers are negative, meaning the values higher 

up on the screen represent stronger signals.  The window can be resized as needed. 

Experiment by placing the spectrum analyzer near working 2.4 GHz systems, such as 

cordless phones or Wi-Fi routers.  You will see either steady peaks in the spectrum or 

peaks that momentarily appear and disappear.  The antenna is built into the circuit board 

inside the white rectangle at the end of the board.  The antenna is somewhat directional 

so you can enhance desired signals and reject others by turning the board in different 

orientations. 



 

Peak Hold 

Many transmissions in this band are pulsed communications, so from one sweep of the 

band to the next, the signal may appear or it might have stopped transmitting at the 

instant that a particular frequency is being monitored.  It is often useful to have the 

spectrum analyzer remember where the peaks were from previous sweeps, so that a more 

complete picture of the spectrum can be seen.  The MiniSA software has the ability to do 

this – just select Peak Hold from the View menu.  This makes the white line for the 

spectrum take on the value of the highest peak that was seen at each frequency.  Select 

the Peak Hold menu item again to turn it off. 

A convenient keyboard shortcut for switching the Peak Hold function on and off is to 

press the Space key. 

 

Center Frequency and Span (Scroll and Zoom) 

Rather than looking at the entire spectrum, you may be interested only in a portion of the 

entire 2.4 GHz band.  To zoom into the spectrum, move the mouse pointer down below 

the bottom horizontal line (where the frequency numbers appear).  The cursor will change 

to a left/right arrow.  By clicking the left mouse button and dragging left and right, you 

can zoom in and zoom out on the waveform.   

When you are zoomed in, you will not be able to see the entire spectrum.  To move the 

graph up or down in frequency, move the mouse pointer up above the bottom of the 

graph.  The cursor will change to a hand.  By left-clicking and dragging the mouse, you 

can scroll the graph left and right. 

 

Zero-Span Mode 

There is a special situation when zoomed in to the maximum level.  The spectrum 

analyzer switches to a faster mode where it only acquires a single frequency and it plots 

this level as a straight horizontal line.  This mode can be useful when observing signal 

strength changes of a signal that is known to be only at a single frequency. 

 

Freeze 

To temporarily stop the spectrum analyzer, select the Freeze item from the View menu.  

Select it again to resume. 



A convenient keyboard shortcut for switching the Freeze function on and off is to press 

the ‘.’ (Period) key. 

 

Export 

MiniSA has the ability to export the spectrum of a signal to a file for use with spreadsheet 

software.  To do this, select Export from the File menu.  Often, selecting Freeze first will 

give you more control over exactly what spectrum will be saved. 

The file will be saved as a CSV (comma separated value) file, which programs like Excel 

can import.  The beginning of the file looks like this as seen in a text editor: 

2400,-92,-91 

2400.33,-93,-90 

2400.66,-93,-90 

2400.99,-95,-91 

2401.33,-91,-91 

… 

Each line is a series of three values: frequency, current spectrum and peak hold spectrum 

(if Peak Hold is turned on). 

This type of file can be formatted to create charts or reports such as the one below (made 

in Excel): 

 



 

Templates 

Spectrum analyzers are often used to examine signals of a particular type, such as WiFi 

signals.  It can be helpful to annotate the signals with information about that type of 

signal, such as the frequency ranges of each of the WiFi channels.  To assist with this, 

MiniSA has the ability to load in template files.  These are graphic files that are drawn 

behind the spectrum waveform. 

To use a template, select Open Template… from the File menu.  Open the desired 

template file.  The image of the file will be placed behind the spectrum graph.  An 

example of an 802.11b access point on channel 9 using the included “WiFi Channels” 

template is shown below. 

 

 

Templates will scroll and zoom with the waveform, so they always maintain the proper 

position with regard to the spectrum waveform. 

Template files are .EMF (Enhanced MetaFile) format graphics files.  These are vector-

based files that can be stretched to any size with no loss of resolution.  Template files can 

be made with any program capable of creating .EMF files, such as Adobe Illustrator.  The 

left side of the image represents 2400 MHz and the right side corresponds to 2485 MHz.  



The image will be stretched or shrunk to fit.  For best results, avoid complex bitmap 

graphic images – they will slow down the screen update rate. 

 

Graph Colors 

The default colors on the graph can be changed if desired.  Select the “Colors…” item 

under the Preferences menu.  A dialog box like the one below will appear. 

 

For each element on the graph (background, text, etc.), a colored button shows the current 

color of that element.  Click the colored button to bring up a color selection window.  

Select the desired new color and click OK.  After choosing all the new colors, close the 

dialog box and the new choices will be seen on the graph.  The color selections you make 

are saved for use next time you run the MiniSA software. 

 

Level Detector 

The Mini Spectrum Analyzer board has a green indicator light that can be configured to 

turn on when the signal reaches a certain level.  The level is set using the dialog box that 

opens when “Level Detector…” is selected from the Preferences menu.  After entering 



the desired level and clicking OK, the light will turn on whenever any part of the 

spectrum exceeds that level. 

 

Arduino Com Port 

Arduino’s USB port appears to be a serial port (Com Port) to Windows.  The MiniSA 

software will try to figure out which com port Windows has assigned to it and will talk to 

the Arduino board on that com port automatically.  In rare cases, this may not work on 

some PC’s.  If you get a message like this: 

 

, select “Configure Com Port” from the Preferences menu and try a different com port 

from the list. 



 

Specifications 

 

Frequency range 2.400 GHz to 2.485 GHz 

Resolution 333 KHz 

Sensitivity Approximately -90 dBm 

Tuning method Swept tuned 

Sweep speed Approximately 6 sweeps/second 

Antenna Built-in folded dipole 

 

 

Limited Warranty 

The Mini Spectrum Analyzer system is warranted to be free from defects in materials and 

workmanship for a period of one year from the date of purchase.  This limited warranty 

covers normal use and does not cover abuse or use not in accordance with this manual. 

Under no circumstance will the seller be responsible for any incidental or consequential 

damages, which may occur during the use of the product, or as a result of the product's 

failure to perform.  In all cases, the customer's sole remedy for a product failure is limited 

to the repair or replacement of the product. 

 


